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Preface

This Preface deals with the Manual—how to navigate it, and how to use it. The remainder of the
Manual is devoted to WriteItNow 6—how to navigate it, and how to use it.

Navigating this Manual

This manual uses “hot” links allowing the reader to navigate easily. For example, if the text states
that the Index starts on page 1, then clicking on that page number (1) takes the reader to the Table of
Contents. (Try it!) The same is true for Part numbers, Chapter numbers, Section numbers, Appendix
letters, Figure numbers, Table numbers, and the page numbers in the Index. In the Table of Contents,
clicking on a Chapter or Section title (not the page number) immediately opens the associated chapter
or section. Web links, such as http://www.ravensheadservices.com/, open the associated web page
in the default browser. Typically the color or shape of the cursor changes when over a hot link, which
can be seen by hovering the mouse over the previous web link.

Terms and Conventions used in this Manual

Convention

Paragraphs containing important information are identified in
a box similar to this.

Paths

Notations such as C: Users Your Name Documents indicate the path to a folder. In this case it shows
where the folder ‘Documents’ is relative to ‘C:’.

Menu Items

Sequences such as Export Book show the hierarchy of menu items. In this case, the menu item ‘Book’ is
under the menu item ‘Export’. The image Setup indicates the sub-menu item ‘Setup’ is to be selected
in WriteItNow 6. This could also be indicated by Export Book Setup .

Printing Errors and Suggestions

If you find any errors in this manual, or have suggestion to improve it, please send them to https:

//ravensheadservices.com/contact_us.php by selecting PDF Manual from the Contact Reason drop-
down menu. Thank you.

Rob Walton, UK
David Lovelock, USA

http://www.ravensheadservices.com/
https://ravensheadservices.com/contact_us.php
https://ravensheadservices.com/contact_us.php
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CHAPTER 1

Starting a New Project in WriteItNow 6

To start using WriteItNow 6 a user must create a new project.
A new project is created by clicking the menu item File on the top left-hand side of the WriteItNow 6

screen, and then selecting New Project as shown in Figure 1.1.

Figure 1.1. Create New Project

A dialog is shown asking if the user wants to save the current project. If nothing has been entered
yet select No.

The Create New Project dialog opens. See Figure 1.2.
Enter a name for the project, and the folder to save it in. This example uses the name ‘The Yellow

Cat’ saved in the My Masterpiece folder. When finished, press the Create button. This creates and
saves a new project called ‘The Yellow Cat’.

The screen should now look like Figure 1.3. The Overview has the title ‘The Yellow Cat’, and all
other sections are empty. This is a blank project with no characters or chapters.



Starting a Project 7

Figure 1.2. Create New Project dialog

Figure 1.3. A blank project

Navigating WriteItNow 6—The Screen Layout

Figure 1.3 shows the main WriteItNow 6 screen. It is divided into three main panels.

1. Menu Panel. Across the top of Figure 1.3 is the Menu panel shown in Figure 1.4.

Figure 1.4. The Menu panel

It contains various menu items, starting with File . In this manual, components accessed under the
Menu Panel are colored black, , and those that start from the Menu Panel itself, for example
File , are shown as Menu Panel File .

2. Tree Panel. On the left-hand side of Figure 1.3 is the Tree panel shown in Figure 1.5.
It is a tree-like structure, starting with Project and ending with Submissions . In this manual, com-
ponents accessed under the Tree Panel are colored blue, , and those that start from the Tree
Panel itself, for example Project , are shown as Tree Panel Project .

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



8 Starting a Project

Figure 1.5. The Tree panel

3. Work Panel. The remaining panel in Figure 1.3 is the Work panel shown in Figure 1.6.

Figure 1.6. The Work panel

This has various tabs across the top—called the Main Tabs—starting with Overview , which is
currently selected. To select any of the tabs, either click on that item in the Main Tabs or on the
same item in the Tree Panel. The large blank area, called the “Main Text Area”, is where all the
text editing is done.
The contents of the Work Panel vary according to the tab selected, but two regions are always
present, the Main Tabs and the Main Text Area.

The Main Tabs

The Main Tabs in the Work Panel is shown in Figure 1.7 on page 8.

Figure 1.7. The Main Tabs in the Work Panel

The contents of each of these tabs is now outlined in order.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



Starting a Project 9

� The Main Tabs Overview tab stores the book’s title, author, and summary.

� The Main Tabs Front Matter tab stores those sections of the book to appear before the body of the
book, such as a preface or a foreword.

� The Main Tabs Chapters tab contains the bulk of the book, usually divided into chapters and scenes.

� The Main Tabs Back Matter tab stores those sections of the book to appear after the body of the
book, such as an afterword or an epilogue.

� The Main Tabs Characters tab stores character information. This includes name, birth and death
dates, a picture, personality and physical details, and relationships.

� The Main Tabs Events tab is where a writer stores details of when things happen.

� The Main Tabs Locations tab stores details of where things happen.

� The Main Tabs Props tab stores any objects and descriptions that are relevant to the story. Typical
props are vehicles, artifacts, weapons, clues, and so on.

� The Main Tabs Notes tab stores any notes. This might include notes on important parts of the story,
research notes, questions to ask experts, writing advice, and other details.

� The Main Tabs Ideas tab stores any thoughts the writer has for the story.

� The Main Tabs References tab holds details of references to publications including authors, publica-
tion dates, publishers, and so on.

� The Main Tabs Submissions tab is where a user can add, delete, and record submission details for a
print book.

The Main Tabs fall into two categories, those that contain the materials to be included in the final
book, called the Book Text, and the remaining tabs, which contain the research materials for the book
(none of which appears directly in the final book), called the Background Details.

Book Text

The tabs in the Main Tabs that are used to create the Book Text are shown in Figure 1.8.

Figure 1.8. The Book Text

Background Details

The Background Details consist of the Main Tabs after the Book Text has been removed, namely
“Overview” and those items shown in Figure 1.9. The inclusion of Background Details in a project is
optional.

Figure 1.9. The Background Details

Projects

A WriteItNow 6 project consists of the two separate components: Book Text and Background Details.

Project = Book Text + Background Details,

shown in detail in Figure 1.10.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



10 Starting a Project

WriteItNow 6 is very flexible and the project could contain just chapters (and possibly scenes) with
no front matter, no back matter, or no Background Details.

Project

Book Text
Background

Details

Front Matter

Chapters and
Scenes

Back Matter

Overview

Characters

Events

Locations

Props

Notes

Ideas

References

Submissions

Figure 1.10. Project components

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 2

Some Editor Commands

WriteItNow 6 contains a fully-fledged editor, with multiple options. In this Chapter, some of the more
important ones are discussed.

Whichever of the Main Tabs is selected, they usually have common items, such as Editor Tools , Edit ,
and Format . See Figure 2.1.

Figure 2.1. Editor Tools, Edit, and Format tabs

Section 2.1

The Editor Tools menu

Clicking on the Editor Tools menu brings up Figure 2.2.
In this section, the Spelling Checker is discussed.

Spelling Checker

The program comes with main dictionaries covering US English, UK English and Canadian English.
Each of these has about 125,000 words. To select the main dictionary—the one used by the spelling
checker—go to Menu Panel Settings Tool Settings Set Main Dictionary . The choice of languages is Canadian
(en CA.dict), UK (en GB.dict), and US (en US.dict).

The Spell Checker is activated either by using the keyboard shortcut Ctrl L or by selecting the
menu item Editor Tools Spelling Checker . The first misspelling is highlighted. If there are close alternatives
to this they are shown in the list of Suggested Replacements. See Figure 2.3.



12 2.1. The Editor Tools menu

Figure 2.2. The Editor Tools

Figure 2.3. The Spell Checker in action

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



Chapter 2. Some Editor Commands 13

If a word has been highlighted it can be changed.

Spell Check Text In Background

Background spell checking is enabled by default. It can be disabled under Settings Tool Settings

Spell Checker Settings .
Misspelled words are highlighted with a wavy underline, as can be seen in the example shown on

Figure 2.4. To change a misspelled word right-click on the word.

Figure 2.4. The Background Spell Checker

The Edit tab

Clicking on the Edit tab brings up Figure 2.5.
This menu item exposes the standard list of items used for editing text, such as Copy, Cut, Paste,

Select, etc. The Import Text From File allows the user to insert text at the position of the cursor, from a
DOC, DOCX, RTF, HTML, HTM, or TXT file.

Section 2.2

The Format menu

Clicking on the Format tab brings up Figure 2.6. This menu item shows options for formatting text,
such as Bold, Italic, left align, right align, etc.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



14 2.2. The Format menu

Figure 2.5. The Edit menu items

Figure 2.6. The Format menu items

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 3

Adding Chapters and Scenes

Having created a project, described in Chapter 1 on page 6, a writer usually either writes chapters
and scenes or creates characters. This and the following chapter of the manual are devoted to writing
chapters and scenes for the book, the next deals with creating characters.

In WriteItNow 6, chapters and scenes are the places to write the text that goes into the book. A
book can consist of any number of chapters and each chapter can have any number of scenes. When
writing the book, text can be put in chapters, scenes, or both.

At this stage the user can either enter text directly, or import an existing Microsoft® Word DOC
or DOCX file. Importing is described in Chapter 10 on page 30.

To enter text directly into Chapters and Scenes go to Chapters either on the Main Tabs or on the
Tree Panel. This opens Figure 3.1.

Figure 3.1. Creating a new chapter

To add a blank chapter click on the button, which opens Figure 3.2.

Figure 3.2. A blank chapter

A title needs to be added, and text can be added now or later. Figure 3.3 shows a partially completed
chapter, with the title ‘A Break’ and some chapter text.
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Figure 3.3. A partially completed chapter

To add more chapters click on the button shown in Figure 3.1. They are automatically added to
the Tree Panel. Figure 3.4 shows part of the Tree Panel for a sample story containing three chapters.
Chapter 1—A Break, Chapter 2—Ancient Tales, and Chapter 3—Leaving.

Figure 3.4. A partially completed chapter

To reorder chapters, go to the Tree Panel and drag and drop the appropriate chapter.
To delete a chapter click on the button. Deleting a chapter also deletes its scenes. It might be

wise to create a snapshot, Ctrl S , before deleting a chapter.

Moving between chapters

To move between chapters, either press the arrow buttons— , , , —in Figure 3.5, or click on
the Go To button. Alternatively, click on the appropriate chapter in the Tree Panel.

Figure 3.5. Moving Between Chapters

Adding a blank scene to an existing chapter

Move to the chapter where the blank scene is to be added. Click on the Scenes tab and then click on
the Scenes button in Figure 3.6.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



Adding Chapters and Scenes 17

Figure 3.6. Adding, deleting, and moving between scenes

Figure 3.7. Chapters and Scenes

Scenes are automatically added to the Tree Panel.
Figure 3.7 shows part of the Tree Panel for a sample
story containing three chapters. Chapter 1—A Break—
has 2 scenes (The Journey Up and Settling In). Chap-
ter 2—Ancient Tales—has 2 scenes (Ancient Treasure
and Searching). Chapter 3—Leaving— has only one scene
(Driven).

To delete a scene move to that scene and click on the
icon in Figure 3.6.

Moving between scenes

To move between scenes, either press the Scenes arrow buttons— , , , —the lower set of buttons
in Figure 3.6, or click on the associated Go To button. Alternatively, click on the appropriate scene in
the Tree Panel. At any stage, scenes can added to a chapter, moved to another chapter, or deleted.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 4

The Story Board

The Story Board is an electronic counterpart of a cork board with index cards—but it is considerably
more powerful. The Story Board can be used to move chapters and scenes around, to add and remove
chapters and scenes, and to edit Chapter and Scene Text, and Chapter and Scene Summary Text.

The Story Board is accessed in a variety of ways.

� Through the keyboard shortcut Ctrl F5 .

� Through the menu item Menu Panel Writing Tools Story Board .

� Through the tab item Main Tabs Chapters Chapter Chapter Tools Story Board .

� Through the tab item Main Tabs Chapters Scenes Scene Tools Story Board .

This brings up the main Story Board, as shown in Figure 4.1.

Figure 4.1. The Story Board

The Story Board shows the chapters as a column down the left. Any scenes associated with a chapter
are shown to its right. The titles of each chapter and scene are also shown. (The default is to show
only titles, however these cards can also show additional information as detailed on page 19.)
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Moving Chapters and Scenes

Chapters and scenes can be quickly and easily rearranged using the mouse.
Click and drag a scene or chapter card to a new location on the Story board by moving the mouse

to a new position. For example, in Figure 4.1, to move Chapter 1 Scene 2 (‘Scene #2 of 2’) to the end
of Chapter 2 just drag the scene to its new position.

If a chapter is moved all the scenes associated with it are also moved. After rearrangement, scenes
and chapters are renumbered.

The Story Board in Figure 4.2 shows Figure 4.1 with the last scene of Chapter 1 moved to the end
of Chapter 2. Note that the moved scene is now renumbered as ‘Scene #3 of 3’.

Figure 4.2. The Story Board rearranged

Context Menus

There are three different context menus that can be seen by right-clicking on a chapter, a scene, or on
a blank area of the cork board. Right mouse click on a chapter or scene for more options.

Blank Area Context menu

Right-clicking on an unused part of the cork board, opens the context menu with one item, Add New Chapter .
Selecting this creates a new chapter. The placement of that chapter depends on where the cork board
is clicked.

Changing What Is Displayed

The Story Board can show different types of text in the chapters and scenes on the board.
At the top of the Story Board is a check box called ‘Show Large Cards’. See Figure 4.3.

Figure 4.3. Show Large Cards check box

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



20 The Story Board

The default is unchecked. In this case the Story Board looks like Figure 4.4.

Figure 4.4. Show Large Cards unchecked

If the ‘Show Large Cards’ box is checked it looks like Figure 4.5.

Figure 4.5. Show Large Cards Checkbox checked

There are four choices.

1. Show Text. This shows the beginning of the chapter or Scene Text that was written in the Main
Text Area.

2. Show Summary. This shows the Scene Summary Text taken directly from the Scene Summary
described in ‘Up and Running with WriteItNow 6 ’.

3. Show Reading Age. This shows the chapter or scene reading age described in ‘Up and Running
with WriteItNow 6 ’.

4. Show Story Structure. This is described in ‘Up and Running with WriteItNow 6 ’.

Selecting ‘Show Text’ gives Figure 4.6.

Figure 4.6. Show Large Cards checked

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 5

Creating Characters

All character information is kept in the Main Tabs Characters tab in Figure 1.7 on page 8. This can
include a physical description; gender; personality; pertinent dates; relationships to other characters;
a photograph; the role the character plays in the book (protagonist, antagonist, major character, . . . );
and so on. This material is purely for reference purposes, and is not part of the printed book. Characters
are part of the Background Details described on page 9.

To add a character to the project, select the Main Tabs Characters tab or the Tree Panel Characters in
Figure 1.3 on page 7. This opens a window similar to Figure 5.1.

Figure 5.1. Creating a character

Clicking on the button, creates a blank character, see Figure 5.2. A blank character is added to
the project and this is shown in the Tree Panel with the icon and the name ‘?’ next to it.
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Figure 5.2. A blank character

In the First Name box, enter the name of a character, say ‘Tom’. See Figure 5.3. The Tree Panel is
updated after the name is typed.

Figure 5.3. Entering the character ‘Tom’

Choose the Gender drop down list and set Tom’s gender to Male. The icon for Tom in the Tree
Panel is changed to show this, . See Figure 5.4.

Figure 5.4. Entering the gender

Repeat these steps to add a few more characters. See Figure 5.5, where two male characters, Tom
and James, and a female character, Lena, have been added. Fill in more details of the characters if
necessary.

To delete a character press the icon.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



Creating Characters 23

Figure 5.5. Adding more characters

To switch to a different character either click the corresponding
name in the Tree Panel; or use the Go To button near the top of

the Work Panel in Figure 5.5; or use the , , , icons.

Instead of creating actual names for characters, it is possible to
use placeholders. For example: [p] is the name of the protagonist,
[pm] is [p]’s mother, [pf] is [p]’s father, [a] is the antagonist, [af] is
[a]’s father, . . . . Then, after the first draft (say) is written, create
the appropriate names all at once, and then do a global search
and replace. This approach has some advantages. It is easy for the
writer to remember who is who while writing. It doesn’t commit
the writer to names at the start which may be abandoned later.
It avoids the writer from remembering a character’s name and its
spelling while writing. Finally, if names are created all at once,
there is less chance of creating similar names that are hard for
the reader to distinguish between. All character names (as well as
many other items) can be printed by right-clicking on Tree Panel

Characters and selecting Print Tree .

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 6

Adding Pictures

WriteItNow 6 deals with two types of entities involving pictures, Picture Links and Picture Tabs.

� Picture Links can occur in any Main Text Area. They are only links to images, and are characterized

by the icon. The associated image is not stored as part of the project, nor is it visible within
WriteItNow 6.

� Picture Tabs are present on characters, events, locations, props, notes, and ideas. The selected
picture is visible within WriteItNow 6.

Section 6.1

Picture Links

Links to pictures on the hard drive can be added anywhere in the Main Text Area.

Adding a Picture Link

1. Select an item on the Tree Panel.

2. Place the cursor in the text where the Link is to be inserted.

3. Either use the keyboard shortcut Alt P or
a) Right-click.

b) Click on the menu item Links which brings up the Links Menu, Figure 6.1.

c) Click on Picture Link .

4. The dialog shown in Figure 6.2 opens. Notice the image of the highlighted file is shown, which
helps the selection process.

5. Navigate to the appropriate image and select it.

6. The Picture Link icon, , is inserted in the text.

Section 6.2

Picture Tabs

Writers often use pictures of some of their characters, events, locations, props, or notes to focus their
thoughts. On each of these Background Details there is a Picture tab that lets the writer import an
image. For example, Figure 6.3 shows an open Location tab, with the Picture tab selected. There are
two options. Use Choose to select a picture and Clear to use no picture.
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Figure 6.1. The Links Menu

Figure 6.2. Picture link

Figure 6.3. Imported picture

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 7

Saving the Project

To save the project select the Menu Panel File menu and choose Save , or use the keyboard shortcut
Ctrl S . The option to save a project is available only in the unlocked version of WriteItNow 6.

A snapshot represents the project at the time it was saved. WriteItNow 6 saves a snapshot of a
project each time it saves the project. A project can be restored from any snapshot.

WriteItNow 6 allows the writer to set how frequently the project is saved, and to select the maximum
number of snapshots to retain. Setting the Auto Save to save every 30 minutes, and setting the maximum
number of snapshots to keep to 100, is usually sufficient.

Auto Save

Frequency of Auto Save

To set how often the program automatically saves a snapshot, go to Menu Panel Settings Tool Settings

Auto Save . Clicking on Auto Save opens Figure 7.1 on page 26, which allows the user to select ‘Auto
Save’ and to identify how often the snapshot occurs.

Figure 7.1. Autosave frequency

Auto Save takes effect after WriteItNow 6 is restarted. It creates a snapshot only if the project has
changed from the previous snapshot. Taking a snapshot is a background operation, and the writer is
unaware of it taking place.

Number of Snapshots

To set the maximum number of snapshots to be kept go to Menu Panel File Restore From Snapshot .
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Clicking on Restore From Snapshot opens a figure similar to Figure 7.2, which allows the user to select
the ‘Max. Snapshots to Keep’. If, for example, the maximum number of snapshots is set to 100, then
WriteItNow 6 keeps up to 100 snapshots. It deletes older snapshots.

Figure 7.2. Max Snapshots to Keep

Restoring a Project from a Snapshot

To restore a snapshot go to Menu Panel File Restore From Snapshot . This opens a window similar to
Figure 7.2, which shows 2 snapshots. The newest is snapshot 1. Click on a snapshot to restore it.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.



CHAPTER 8

Exporting the Project

Exporting is the process of converting a WriteItNow 6 project, or part of a project, into a file formatted
for use with an external program, such as Microsoft® Word or Adobe Reader®. It does not alter the
project.

To create a manuscript, PDF, or eBook the project needs to be exported. To do this select the
Menu Panel Export menu and choose Book , followed by As DOC (MS Word Format) , that is Menu Panel

Export Book As DOC (MS Word Format) . This creates a manuscript in Microsoft® Word format and
opens the document in that program (if installed on the computer). Creating a DOCX, eBook, PDF
document, or RTF document follows the same pattern.

The way the book is formatted can be changed by selecting Menu Panel Export Book Setup .



CHAPTER 9

Backing Up and Transferring a Project

Backing up a Project

Backing up computer files should be a regular task. All hard drives fail eventually. Backing up to the
same hard drive is asking for trouble. It is much better to back up to an external hard drive or to the
cloud. Better still, back up to both—regularly. See https://www.techradar.com/best/best-free-

backup-software for a list of free backup programs, with reviews.
The most important thing to back up is the project file! If only one item is backed up, make sure

it is this. If you have pictures make sure you back up the pictures folder. The project file is the one
ending in *.wnwx, for example, My Book.wnwx. The pictures folder is a sub folder which is created in
the folder where the project is saved.

Transferring a Project from one Computer to Another

This can be done in two different ways.

� Using a thumb drive.

� Using one of the many free1 cloud services available, such as “Dropbox” (https://www.dropbox.
com/), or “OneDrive” (https://onedrive.live.com/), and so on. (There can be issues with access
immediately after exporting or saving to a cloud-linked folder for projects.)

Whichever method is chosen, the process is essentially the same.

� Use the backup procedure described in the previous section “Backing up a Project” to copy the
data from the source computer to the thumb drive or cloud.

� Install WriteItNow 6 on the destination computer, if it is not already installed. Unlock it with your
unlock codes.2

� Copy the data from the thumb drive or cloud to the relevant folders in the destination computer.

1 Each of these web file storage services have a basic amount of free disk space.
2 “You can install and use WriteItNow 6 on any computers which you own or use regularly as long as the installation is

for your own use.”

https://www.techradar.com/best/best-free-backup-software
https://www.techradar.com/best/best-free-backup-software
https://www.dropbox.com/
https://www.dropbox.com/
https://onedrive.live.com/


CHAPTER 10

Importing Existing Text

Importing is a way to get text from other sources into WriteItNow 6, without retyping. For example, if
someone has started a book in Microsoft® Word they can import this into WriteItNow 6, and continue
writing it.

Supported formats are DOC (Microsoft® Word), DOCX (Microsoft® Word), RTF (most word
processors), HTM (web page), HTML (web page), and plain text TXT (most text editors). There is
no provision for importing PDF documents. This chapter is devoted to importing a DOC file. The
remaining file types are imported in a similar way.

Before importing it would be wise to save the current project in
case the import produces an unexpected result.

There are two ways to import text from other sources: Automatic Importing—where no text is
selected by the user—and Interactive Importing—where the text to be imported is selected by the
user. Each of these options is accessed from the Menu Panel via the Import menu item, see Figure 10.1.

Figure 10.1. Import Menu

Whichever method is selected, the file to be imported should be prepared ahead of time to identify
different sections—Chapters, Scenes, Front Matter, Back Matter, Characters, Events, Locations, Props,
Notes, and Ideas. An unprepared file can be imported directly, but it will come in as one long chapter.

The simplest method is to identify each section with its category name (Chapter, Scene, . . . ) and
then use Automatic Importing. For example, after automatic importing, the text

CHAPTER I am Born

Whether I shall turn out to be the hero of my own life, or whether that station
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will be held by anybody else, these pages must show.

SCENE The Beginning

To begin my life with the beginning of my life, I record that I was born (as I

have been informed and believe) on a Friday, at twelve o'clock at night.

CHARACTER David Copperfiled

David was born in Blunderstone, Suffolk, near Great Yarmouth, Norfolk, England,

in 1820, six months after the death of his father.

LOCATION Blunderstone, Suffolk

Blundeston is a village and civil parish in the Waveney district of the English

county of Suffolk.

EVENT Birth of David Copperfield

April 28, 1820

PROP Book

"David Copperfield" by Charles Dickens

NOTE Read David Copperfield

Take out of library

IDEA Another book

Oliver Twist is a good title.

creates a chapter titled “I am Born”, a scene titled “The Beginning”, and so on. See Figure 10.2.

Figure 10.2. A project using Automatic Import

If, for example, an existing scene has no title, then the word “Scene” on its own line will create a
scene titled “Scene”.
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CHAPTER 11

Writing Targets

Writing targets can be set to show how many words have been written in a session and how long has
been spent writing in the session. They are calculated automatically from when the program is opened.
Targets can be shown or hidden.

Setting Writing Targets

To set writing targets go to Menu Panel Writing Tools Writing Targets or use the keyboard shortcut
Ctrl F7 . This opens a window similar to Figure 11.1.

Figure 11.1. Setting Writing Targets

Figure 11.1 is divided into two sections: Words and Time.

Words

This section is associate with the number of words written.

1. Words Written. This shows the number of words written since the session start.
2. Reset Words Written. Clicking the Reset Words Written button sets the number of words written back

to zero.
3. Targets. The total number of words the user wants to write as a target for this session.
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4. Show Words Written. If this is checked then the words written target is shown below the Work
Panel.

The number of words written is shown below the Work Panel. Figure 11.2 is an example. It shows
the number words written, ‘16’, the target set, ‘500’ words, and a progress bar, ‘3%’.

Figure 11.2. Words Written

The words target shows words written. It does not include any
words that have been cut and pasted into the project. Deleting text
does not reduce the number of words written.

When exiting the program the writing target is updated using the number of words already written.
For example, if the writing target is set at 500 words and 300 words are written, then on exit the target
is changed to 500 − 300, or 200 words.

If a user wants the writing target to always start at a particular
value for each session then select Menu Panel Settings Tool Settings and
ensure that “Update Word Target on Program Exit” is not selected.

Time

1. Time Wiriting. Shows the amount of time that has been spent writing since the session start.
2. Reset Time Writing. Clicking the Reset Time Writing button sets writing time back to zero.
3. Target. This is the target time for writing in hours and minutes.
4. Maximum Pause. This sets the maximum pause in seconds before the writing timer stops. For

example, if this is set to 10 seconds then any pause greater than 10 seconds pauses the timer. The
timer restarts when the next word is written. If the maximum pause is set to 600 seconds then the
writer could stop writing for ten minutes before the timer pauses. A reasonable value is from 10
to 60 seconds. By default the maximum pause is set to zero. When set to this value the elapsed
time increases constantly.

5. Show Time Writing. If this is checked then the writing time target is shown below the Work Panel.

The time spent writing is shown below the Work Panel. Figure 11.3 is an example. It shows the
time spent writing, ‘00:31:04’ (a little over 31 minutes), the target time set, ‘01:00:00’ (one hour), and
a progress bar, ‘51%’.

Figure 11.3. Time Writing

Historical Record

Going to Menu Panel Charts Writing Targets gives a graphical representation of the previous occasions
on which the writing targets were reached.

© 2015–2020 Ravenshead Services, Ltd. 2021-08-09.
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Simply sitting staring at the screen and not writing does not
count towards the target. Pausing for longer than the maximum
pause time allotted pauses the time target.
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CHAPTER 12

Getting More Help

There are two complimentary ways of getting help in WriteItNow 6.

1. Help built into WriteItNow 6.

2. Web tutorials.

Help built into WriteItNow 6

WriteItNow 6 has extensive help, which can be displayed either within WriteItNow 6 or in the default
web-browser. The choice is made from Menu Panel Settings Tool Settings , by checking or unchecking
Use Web Browser to Show Help .

Help is obtained in three ways.

� By using Menu Panel Help . The Search option searches the Help for any text, while Index displays
an alphabetical index of Help items. The remaining menu items are topic-specific or offer general
help to the user.

� By pressing the F1 key.

� By clicking the question mark icon , when available.

Web Tutorials

If the computer is connected to the Internet, then by selecting Menu Panel Help Web Tutorials , various
instructional videos on the use of WriteItNow 6 can be viewed.

Support for WriteItNow 6

To contact the authors of WriteItNow 6 with any questions go to https://ravensheadservices.com/

contact_us.php.

https://ravensheadservices.com/contact_us.php
https://ravensheadservices.com/contact_us.php
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